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Agenda

9:00 AM – 12:00 PM Start Tools Installation

STM32G0 Overview

Lab: Blink an LED by software

Lab: Use hardware (PWM timer) to blink an LED

Lab: External Interrupt

Lab: Low power

Optional Lab: Power Consumption Estimation

Optional Lab: Printf
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Begin Tools Installation 3

• Copy the content of the USB drive to a temporary directory on your machine 
(i.e. C:\temp)

• Install Java

• Install Keil uVision 5

For more details on the tools installation, refer to the document “STM32G0 
Workshop Installation from USB drive_v1.0.pdf” part of the files you copied 
from the USB drive



STM32G0 MCU series
Efficiency at its best



5STM32G0: great investment
Keep releasing your growing creativity

Ultra-low-power

Mainstream

Cortex-M0
Cortex-M0+

Cortex-M3 Cortex-M4 Cortex-M7

High-performance

Wireless

Cortex-M33

new

Note    : Cortex-M0+ Radio Co-processor



Cortex-M Seamless scalability 6

Floating Point Unit (FPU)
DSP (SIMD, fast MAC)

Advanced data 
processing
Bit field 
manipulations

General data 
processing
I/O control tasks

Cortex-M4 / M7
Extended Performance

Foundation

Budget price

STM32 
F0/L0/G0
STM32 

F0/L0/G0

STM32 F1/F2/L1

STM32 F3/F4/F7/L4

Cortex-M3

Cortex-M0/M0+



Key messages of STM32G0 series

1

2

3
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Efficient 
• ARM Cortex M0+ at 64MHz
• Compact cost: maximum I/Os count
• Best RAM/Flash Ratio 
• Smallest possible package down to 8-pin 

• Very low power consumption (3µA in stop, 
<100µA/MHZ in Run)

• Accurate internal high-speed clock 1% RC 
• Best optimization, down to each and every detail
• Offers the best value for money

Robust
• Low electromagnetic susceptibility, EMC
• Clock Monitoring and 2 Watchdogs
• Error correction on Flash

• IoT ready with embedded security
• Hardware AES-256 encryption
• New Securable Memory Area
• Safe Firmware upgrade / Install

Simple
• Easy to configure thanks to the intuitive and 

graphical STM32CubeMX configuration tool

• Easy to develop based on the Hardware 
Abstraction Layer library (HAL) or the low-layer 
library (LL) allowing maximum re-use and faster
time-to-market



Wider platform

Portfolio streeeeeeeeeetched for efficient budget applications

More memory and pin counts

QFN

LQFP

WLCSP

More packages

BGA

SO / TSSOP

512K flash
Big flash

Small package

8pin

8



Reducing BOM cost 9

STM32G0

Standard

MCU

smaller package

less surrounding components

clock

Vdd          Vss

Vdd

Vss

Vdd

Vss

Vdd

Vss

Vdd

Vss

New platform optimized with 1 power supply pair only up to 64pin packages



Innovations for your benefit 10

• No external clock -10cts

• No decoupling capacitances -4cts

• Smaller PCB -1cts

• USB-C power delivery -15cts

• Secure programming -25cts

Additional benefits for your convenience:

Remove up to 6 decoupling capacitors for supply and clocks

Accurate internal high speed clock +/-1% for 0 / 90°C

Smaller package, less components: save on PCB area

Integrated transceivers, pull-up/down resistors and digital

In house or at 3rd parties
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Performance with 0, 1 and 2 wait state

Series1

Series2

Providing more performance

• Up to 64 MHz/ 59 DMIPS

• Up to >142 CoreMark Result

• ARM Cortex-M0+ with Memory Protection Unit 

(MPU)

• Flexible DMA up to 12 channels 

Do not compromise on performance with STM32G0

64

142.88

Prefetch on

Prefetch off
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12Low-power modes efficiency

When Mainstream MCU Series meets low-power requirements

Conditions: 25°C, Vdd = 3V

Note : * without RTC / with RTC

Tamper: few I/Os, RTCVBAT                  10 nA / 400 nA*

Wake-up sources: reset pin, few I/Os, RTC SHUTDOWN             40 nA / 500 nA*258 µs

Wake-up time

Wake-up sources: any interrupt
or event

6 cycles SLEEP 800 µA

RUN at 64 MHz                                                     <100 µA / MHz

5 µs
Wake-up sources: + all I/Os, PVD, 
COMPs, LPUART, LPTIM, I²C, UART, 
USB-PD

STOP      3.0µA / 5µA / 8µA

14 µs Wake-up sources: + BOR, IWDG STANDBY                         200 nA / 500 nA* 

24MHz, Vdd=3V, PLL=on

Flash-RTC  off-off/off-on/on-off



Ready for tomorrow 13

Faster, more accurate analog and digital functions

• More RAM for Flash

• Up to 36KB SRAM for 128KB and 64KB Flash

• Timers frequency up to 128MHz resolution (<8ns)

• Advanced control capabilities

• 12-bit ADC up to 2.5MSPS (0.4µs) conversion time

• 16-bit oversampling by hardware

• 32Mbit/s SPI, 7 Mbaud/s USART, 1Mbit/s I²C 
communication

upgrade

Budget MCU
world



14

SPI / UART / I²C
4x SPIs 
8 USARTs (ISO 7816, LIN, IrDA, modem) 
3 I²C

I/Os Up to 92 fast I/Os

TRNG & AES 
for Security
128-/256-bit AES
key encryption hardware 
accelerator 

VBAT with RTC
for battery backup 
400 nA in VBAT mode 
for RTC and
20x 32-bit backup registers

USB
USB 2.0 
Full speed
Device / Host

USB-C Power Delivery
Up to 2 ports with dead-battery management

Timers
8ns PWM resolution
Advanced control
16- and 32-bit

FD CAN 
Up to 2 instances

Smart peripherals

Comparators
2 instances
Down to 30ns propagation delay

DAC
2x 12-bit DAC,

ADC
16x12-bit, 16-bit oversampling
2.5MSPS (0.4µs)

OBD Industrial



Smart integration 15

Save on battery life

Low consumption process and design
Low-Power UART: wake-up on frame
Low-Power Timer: counts and generate signals
I²C wake-up on address

Save on BOM cost

Main Clock monitoring
Backup clock and interrupts
Voltage monitoring: programmable interrupts
and reset
Window watchdog on CPU clock
Independant watchdog on independant clock
Checksum by hardware
ECC on Flash, Parity on RAM

High temperature
from -40°C
up to + 125°C

Always keep control
Diagnose, react

+/-1% high speed clock internal from 0 to 90°C
+/-2% high speed clock internal from -40 to 125°C
IO maximization: smaller package footprint

More flexibility

More RAM or more safety with parity enable/disable
Dynamic DMA assignement on DMAMUX
All IOs with external interrupt capability

High robustness
Highly immune to fast-transients
Robust IOs against negative injections



Smartphones, IoT devices, 
rechargeable connected
devices, drones, toys
• Low-thickness, small form-factor
• 64MHz CPU with DMA
• Low consumption in run and low-

power, fast wake-up
• USB type-C Power Delivery 3.0
• USB FS 2.0 dev/host crystal-less

Smart applications 16

Lighting

Smart Home

Consumer objects

Home appliances, alarms and 
safety, advanced user interfaces
• High temperature 125°C
• Safety monitoring features
• More RAM for flash
• Low consumption <100µA/MHz 

in run

• High temperature 125°C
• Fast CPU 64MHz
• Advanced timers with 

high-resolution 7.8ns
• Fast comparators
• ADC-12bit, DAC-12bit
• Low-thickness packages
• AES & security for secure 

upgrades

Industrial devices
Motor control

Advanced control

Air conditioning, e-bikes, 
industrial equipments
• High temperature 125°C
• CANFD support
• SPI, USART, I²C
• Advanced timers with 

high-resolution 7.8ns
• Real Time Clock with 

backup registers
• AES & security for secure 

upgrades



STM32 G0 product lines

Communication Peripheral:
USART, SPI, I²C

Multiple general-purpose 
16-bit timers

Integrated reset and brown-
out waming

DMA channels

2x watchdogs 
Real-time clock (RTC)

Integrated regulator
PLL and clock circuit

Main oscillator and 
32 kHz oscillator

Internal RC oscillators
32kHz , 16 MHz 

-40 to +85 °C

Low voltage 1.65 to 3.6 V
(Value Line: 2.0 to 3.6V)

Temperature sensor

Common peripherals 
and architecture:

ARM Cortex-M0+
64MHz

0.93 DMIPS/MHz

STM32G0x1 – Access Line (ex: STM32G071)

Up to 

80KB 
SRAM

Up to 

512KB 

Flash

STM32G0x0 – Value Line (ex: STM32G070)

Up to ç-

80KB 
SRAM

Up to 

512KB 

Flash
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MPU

STM32G0+11 – Access Line & Encryption (ex: STM32G081)

1x 16-bit 

MC Timer
>100MHz

Up to 

80KB 
SRAM

Up to 

512KB 

Flash

2x Comp

2x 12-bit 
DAC.

1x16-bit

Timer
>100MHz

12-bit 

ADC 
2.5MSPS

CAN-FDUSB-PD AES

TRNG

1x 16-bit 

MC Timer
>100MHz

2x Comp

2x 12-bit 
DAC

1x16-bit

Timer
>100MHz

12-bit 

ADC 
2.5MSPS

USB  

OTG 
2.0 FS

USB-PD

12-bit 

ADC 
2.5MSPS

CAN-FD

USB  

OTG 
2.0 FS

1x 32-bit 

Timer

1x 32-bit 

Timer

Securable

Memory
Area

Securable

Memory
Area

U
p
 t
o
 +

1
2
5
°C

On some part-numbers



STM32G0 Portfolio 18

G071/ G0B1

G081/ G0C1

G070

G071/ G0B1

G081/ G0C1

G070

G071/ G0B1

G081/ G0C1

G070

G071

G081

STM32G071

STM32G081

STM32G071

STM32G081

G031/ 71

STM32G081

STM32G071

STM32G081

G031G031G031G031

G041 G041 G041

G030 G030

G0B1

G0C1

G0B0

G0B1

G0C1

G0B1

G0C1

G0B1

G0C1

G0B0

20pin 32pin 64pin 100pin8pin 28pin

TSSOP LQFP
UFQFPN

LQFP
UFQFPN

LQFPSON UFQFPN

48pin

LQFP
UFBGA Access

Access AES

Value

32K

64K

128K

512K

256K

G041

G030

G031

G041

G030

G071

G081

G031/ 71

G041/ 81G041/ 81

G031/ 71

G041/ 81

+ WLCSP25 STM32G081
+ WLCSP18 STM32G041

G030 G030

G031

G041



Access Line

Advanced features and solutions

• Arm 32-bit Cortex-M0+ core

• 1.7 to 3.6V power supply

• RAM maximization

• 1% internal clock 

• Direct Memory Access (DMA)

• Communication peripherals

• USB-C Power Delivery

• Timers up to 2xfcpu resolution

• Real Time Clock

• I/O ports maximization

• ADC 12-bit Ultra-fast

• DAC 12-bit

• Comparators

• Safety features 

• Advanced Security features

19



Value Line

No compromise on what matters

• Arm 32-bit Cortex-M0+ core

• 2.0 to 3.6V power supply

• RAM maximization

• 1% internal clock 

• Direct Memory Access (DMA)

• Communication peripherals

• Timers

• Real Time Clock

• I/O ports maximization

• ADC 12-bit Ultra-fast

• Safety features 

20



More security

Integrated security features, ready for tomorrow’s needs

User flash

Standard user flash by default

Can be secured once exiting
No more access nor debug

Configurable size

Good fit to store critical data
• Critical routines
• Keys

Securable Memory Area

Execute-only Protection

Read-out Protection

Write Protection

Memory Protection Unit (MPU)

AES-256 / SHA-256 Encryption

True Random Number Generator

Unique ID

Firmware IP protection

Mutual distrustful

Authentication

Secure firmware upgrade

Secret key storage

Securable 
Memory Area

21



22
LQFP64 pin-to-pin comparison

Extra-port vs STM32F0 

51 I/Os
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64 63 62 61 60 59 58 57 56 55 54 53 52 51 50 49

PC11 1 48 PC8

PC12 2 47 PA15

PC13 3 46 PA14 - BOOT0

PC14 - OSC32_IN 4 45 PA13

PC15 - OSC32_OUT 5 44 PA12

VBAT 6 43 PA11

 VREF+ 7 42 PA10

VDD_1 8 LQFP64 41 PD9

VSS_1 9 40 PD8

PF0 - OSC_IN 10 39 PC7

PF1 - OSC_OUT 11 38 PC6

PF2 - NRST 12 37 PA9

PC0 13 36 PA8

PC1 14 35 PB15

PC2 15 34 PB14

PC3 16 33 PB13

17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32

P
A

0

P
A

1

P
A

2

P
A

3

P
A

4

P
A

5

P
A

6

P
A

7

P
C

4

P
C

5

P
B

0

P
B

1

P
B

2

P
B

1
0

P
B

1
1

P
B

1
2

60 I/Os

• 9 IOs more on STM32G071 vs STM32F071

• 5 IOs more on STM32G071 vs STM32F051

STM32F071 STM32G071



23
Consistent and optimized pinout
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64 63 62 61 60 59 58 57 56 55 54 53 52 51 50 49

PC11 1 48 PC8

PC12 2 48 47 46 45 44 43 42 41 40 39 38 37 47 PA15

PC13 3 1 36 46 PA14 - BOOT0

PC14 - OSC32_IN 4 2 32 31 30 29 28 27 26 25 35 45 PA13

PC15 - OSC32_OUT 5 3 1 24 34 44 PA12 [PA10]

PF3 - VBAT 6 4 2 23 33 43 PA11 [PA9]

PF4 - VREF+ 7 5 3 22 32 42 PA10

VDD_1 8 6 4 21 31 41 VDD/VDDIO2

VSS_1 9 7 5 20 30 40 VSS_2

PF0 - OSC_IN 10 8 6 19 29 39 PC7

PF1 - OSC_OUT 11 9 7 18 28 38 PC6

PF2 - NRST 12 10 8 17 27 37 PA9

PC0 13 11 9 10 11 12 13 14 15 16 26 36 PA8

PC1 14 12 25 35 PB15

PC2 15 13 14 15 16 17 18 19 20 21 22 23 24 34 PB14

PC3 16 33 PB13
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P
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4 UFQFPN28 - GP 18

5 17
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7 15
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PD9

PD8

QFP64
QFP/QFN48
QFP/QFN32
QFN28



STM32G0 ecosystem 24

5

HARDWARE TOOLS

Full feature 
evaluation

Flexible 
prototyping

Key feature 
prototyping

STM32 Nucleo Discovery kit Evaluation board

SOFTWARE TOOLS

STM32CubeMX featuring intuitive pin selection, clock tree 
configuration, code generation and power consumption 

calculation

Go fast, be first



STM32G0 ecosystem 25

EMBEDDED SOFTWARE

• Open-source FAT file system (FatFs)
• Open-source real-time OS (FreeRTOS)
• Dozens of examples

• STM32G0 Hardware Abstraction Layer (HAL) portable APIs
• High-performance, light-weight low-layer (LL) APIs
• High coverage for most STM32 peripherals 
• Production-ready and fully qualified 
• Dozens of usage examples
• Open-source BSD license

Platform approach or custom code: you choose

STM32CubeG0
HAL + Low-Layer drivers

CMSIS



SUMMARY  3 Keys of STM32G0 series

1 Efficient 

Robust

Simple

2

3

26



Continue with the tools installation 27

• By this time Keil uVision 5 should be installed

• Install STM32G0 Pack for Keil uVision5 (From Pack Installer)

• Activate Keil uVision5 (from Keil uVision5)

For more details on the tools installation, refer to the document “STM32G0 
Workshop Installation from USB drive_v1.0.pdf” part of the files you copied 
from the USB drive



STM32CubeMX 5.0

STM32CubeMX graphical software configuration tool 



Introduction 29

STM32CubeMX

STM32CubeL1

STM32CubeF1

STM32CubeF2

STM32CubeF4

STM32CubeL0

STM32CubeL4

STM32CubeF0

STM32CubeF3

STM32CubeF7

STM32CubeH7

STM32CubeG0



Overview 30

• Choose ideal MCU 
and simply 
configure

• Pinouts

• Clocks and oscillators

• Peripherals

• Low-power modes

• Middleware

• Helps choose the correct MCU for a given purpose

• Simulation provides an advantage in design phase

• Boosts development speed with a headstart

Application benefits



Key features

• Peripheral and middleware parameters

• Power consumption calculator

• Code generation

• Possible to re-generate code while keeping user code 
intact.

• Option of command-line and batch 
operation

• Expandable by plugins

31

• MCU selector

• Filter by family, package, peripherals or memory sizes.

• Search for similar product.

• Pinout configuration

• Choose peripherals to use and assign GPIO and 

alternate functions to pins.

• Configure NVIC and DMA

• Clock tree initialization

• Choose oscillator and set PLL and clock dividers.



MonitorGenerate Code Compile &  Debug

STM32CubeMX Partners IDEs STMStudio

Comprehensive choice of IDEs

Free 
IDE

32



STM32G071 Block diagram
Main specification

• 1.65V to 3.6V 

• 0.93 DMIPS/MHz

• Vbat supply

• Vref+ pin

• Max ambiant temp 125°C

• One Supply pair

• Securable Memory Area

• High sink I/Os

• <100µA/MHz run mode

• Stand-by <1µA @ room temperature

• Stop 5 µA @ room temperature

• Shutdown mode

• Low EMI SAE (2.5@24MHz)

• Robust EMC/ESD/EMS

• 28/32/48 and 64 pins

33

Up to 64 MHz

ARM Cortex-M0+ CPU

Memory Protection Unit

Up to 64 MHz

ARM Cortex-M0+ CPU

Memory Protection Unit

Nested vector interrupt 
Controller (NVIC)

SW debug

SystemSystem

Up to 36-Kbyte SRAMUp to 36-Kbyte SRAM

Up to 128-Kbyte
Flash memory
Up to 128-Kbyte
Flash memory

BOOT ROMBOOT ROM

ControlControl2x watchdogs
(independent and window)

2x watchdogs
(independent and window)

1x16-bit  Motor C. timer 
fmax > 100Mhz                  

4 PWM + 3 compl.

1x16-bit  Motor C. timer 
fmax > 100Mhz                  

4 PWM + 3 compl.

Power supply
1.2 V regulator

POR/PDR/PVD/BOR

Power supply
1.2 V regulator

POR/PDR/PVD/BOR

Xtal oscillator
32 kHz + 1~56 MHz
Xtal oscillator
32 kHz + 1~56 MHz

Internal RC oscillators
32kHz (+/-5%) + 16 MHz (1%)

Internal RC oscillators
32kHz (+/-5%) + 16 MHz (1%)

FLL + PrescalerFLL + Prescaler

Clock controlClock control

RTC/AWURTC/AWU

Systick timerSystick timer

Cyclic redundancy check 
(CRC)

Cyclic redundancy check 
(CRC)

7-channel DMA7-channel DMA

60 I/Os on 64 pins60 I/Os on 64 pins

AHB-Lite bus matrix

20 byte backup registers20 byte backup registers

ConnectivityConnectivity

2xSPI  (I²S)2xSPI  (I²S)

4xUSART
(2x with LIN, smartcard, 
IrDA, modem control)

4xUSART
(2x with LIN, smartcard, 
IrDA, modem control)

5x16-bit timer                    
2 PWM each                  

one with fmax > 100Mhz

5x16-bit timer                    
2 PWM each                  

one with fmax > 100Mhz

APB bus

AnalogAnalog

2 x Comparators2 x Comparators

2xI2C
(SMBus, PMBus, Fast 

Mode Plus)

2xI2C
(SMBus, PMBus, Fast 

Mode Plus)

1x 12-bit ADC SAR           
16-channels / 2MSPS

1x 12-bit ADC SAR           
16-channels / 2MSPS

Temp. sensorTemp. sensor

1xLPUART1xLPUART

2x Low Power timer2x Low Power timer

1x 32-bit timer1x 32-bit timer

features highlightfeatures highlight
1 x 12-bit DAC 2ch.1 x 12-bit DAC 2ch.

USB PDI                      
(Power Delivery Interface : 

incl. BMC + PHY)

USB PDI                      
(Power Delivery Interface : 

incl. BMC + PHY)



System architecture overview

• Two masters:

• Cortex®-M0+ core

• General-purpose DMA

• Three slaves:

• Internal SRAM

• Internal Flash memory

• AHB with AHB-to-APB bridge that 
connects all the APB peripherals

• Dedicated IOPORT for accessing 
the GPIOs

34



Simplified clock tree 35

HSI16

HSE

PLLCLK

/ M
* N

/P

PLL

VCO

/Q

/R

SYSCLK

PLLRCLK

AHB 
PRESCALER

/1…512

HCLK APB PRESCALER
/1…16

PCLK To APB 
peripherals

To CPU, DMA, memories, AHB peripherals

/ 32

LSE

LSI

To RTC

LSE
Available in VBAT 
and all low-power 

modes

LSI
Available in all 
modes except 

Shutdown and VBAT 
mode

HSIDIV
/ 1…128

LSE

LSI

PLLQCLK

PLLPCLK

HSISYS



STM32Cube and STM32CubeMX



Introduction 37

STM32CubeMX

STM32CubeL1

STM32CubeF1

STM32CubeF2

STM32CubeF4

STM32CubeL0

STM32CubeL4

STM32CubeF0

STM32CubeF3

STM32CubeF7

STM32CubeH7

STM32CubeG0



STM32Cube



Overview 39

• Single package

• Compatible with all STM32 series

• Source code with open-source BSD license

Application benefits

Low level drivers

HAL examples

Board demonstrations

Evaluation boards Discovery  boards Nucleo boards

Middleware level examples

Middleware
CMSIS

Utilities

PC SW

Middleware level

USB 
Host Library

File system
FATFS

Graphics
STemWin

TouchGFX

USB 
Device Library

RTOS
FreeRTOS

Polar SSLLibJPEG
Audio 

Addons
Networking

LwIP TCP/IP

STM32 
Series

STM32F0 STM32F1 STM32F2 STM32F3 STM32F4

STM32L0 STM32L1 STM32L4STM32F7 STM32H7

STM32G0

Boards Support 
Packages (BSP)

Low-layer APIs
(LL)

Hardware Abstraction 
Layer (HAL)

USB Power 
Delivery



STM32CubeMX



Overview 41

• Choose ideal MCU and 
simply configure

• Pinouts

• Clocks and oscillators

• Peripherals

• Low-power modes

• Middleware

• Helps choose the correct MCU for a given purpose

• Simulation provides an advantage in design phase

• Boosts development speed with a headstart

Application benefits



Pin assignment 42

• Pinout from:

• Peripheral tree

• Manually

• Automatic signal 
remapping

• Management of 
dependencies between 
peripherals and/or 
middleware
(FatFS, USB …)



Peripheral and Middleware configuration 43

• Global view of used 
peripherals and 
middleware

• Highlight of 
configuration errors

+ Not configured

ⱱ OK

Non-blocking problem

x Error

GPIO configuration 
is considered 

incorrect, but code 
may be generated

Click to 
configure DMA

Error in 
configuration, code

generator will 
display a warning 

message

Configuration 
is valid here

Quickly switch 
pinout and 

system view



Clock configuration 44

• Immediate 

display of all 
clock values

• Active and 

inactive clock 
paths are 

differentiated

• Management of 
clock constraints

and features



PCC (Power Consumption Calculator) 45

General PCC 
configuration 

panel

Sequence 
configuration

Result

overview



STM32CubeProgrammer features 46

• Main Features:

• Unify existing programming software tools : 
Merge STVP, ST-Link Utility 
and Bootloader softwares tools in one solution.

• Multiplatform 
(Windows, Linux and macOS)

• Debug and bootloader interfaces support: ST-
LINK debug probe (JTAG/SWD),  Bootloader 
interfaces (UART, USB DFU, SPI, I²C and CAN)

• Secure programming



Finish the tools installation 47

• Install STM32CubeMX

• Install STM32CubeProgrammer

• Install STM32CubeG0 FW Library

• Tera Term

For more details on the tools installation, refer to the document “STM32G0 
Workshop Installation from USB drive_v1.0.pdf” part of the files you copied 
from the USB drive



Validate the Tools Installation 48

• Run The Tool Validator as administrator (part of the files you copied from the 
USB drive) to validate the tools installation.

• When running the tool you should get:

• If you don’t, please let us know



STM32 NUCLEO features

Integrated ST-Link/V2-1:

mass storage device flash programming

One STM32 MCU flavor with 64 pins

Arduino extension connectors : 

easy access to add-ons

Morpho extension headers : 

direct access to all MCU I/Os

2 push buttons, 2 color Leds

Flexible board power supply :

through USB or external source

49

We are now going to provide you with the STM32G0 Nucleo board and the USB cable.



Board Check
• Connect USB ST-LINK (CN2) to your PC

• ST-LINK driver may be installed if this is the first time the board is plugged in.

• LD1 should be ON and solid RED (indicating board power available 
and ST-Link is functional)

50

LD1

CN2

LD4User Button

Note about Virtual Box or VMWare or Parallels users:  you need to give USB resources (ST-LINK in our case) from Native OS to 
Windows environment.



Lab: Blinky



Lab: Blinky 52

Objective:

• The objective of this lab is to generate a very simple project using 
STM32CubeMX Software.

• In this example we are going to blink one of the LEDs present on the 
STM32G0 Nucleo board, connected to PA5 of the STM32G0 MCU.



Run STM32CubeMX 53

1

Double Click on 
STM32CubeMX 
icon on your 
desktop

2

Click “No” when this 
window appears

3

This is how 
STM32CubeMX will 
look like when open



Step 1: Create New Project 

• Click Access To MCU Selector

• Type: “stm32g071rb” in the Part 
Number Search

• Select STM32G071RBTx
• LQFP64, 128kB Flash

• Double Click

1

3

2

2

3

1
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Step 2: Pin Configuration 55

• In this example we are going to use one of the LEDs present on the STM32G0 
Nucleo board (connected to PA5 as seen in the schematic below)

• Search for PA5 in the search window at the bottom right

• Left-click PA5 and set it to GPIO_Output mode



Step 3: Generate Source Code 

• Open Project Manager

• Set the project name (blinky) and the project 
location (C:\STM32G0Workshop\HandsOn)

• Set the IDE Toolchain to MDK-ARM V5

• Generate Code

• Click Open Project
3

1

2

1

2

3

Note: STM32CubeMX projects have an ioc file extension
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Free MDK-ARM for ST

• Free licenses for STM32 devices based on 
Cortex-M0/M0+ cores :

• Applicable immediately to all STM32G0, STM32F0 and 

STM32L0 MCUs.

• PC-locked multi-year licenses.

• No code size limit.

• Multiple language support.

• Technical support included.

• Direct download from Keil website :

• No limit of number of downloads by customer.

• Direct access to configuration files for STM32 and 
associated boards.

• Free access to MDK-ARM periodic updates.

• To get a free MDK-ARM license for 
STM32F0,STM32L0 and STM32G0:

• Go to Keil website at : www.keil.com/mdk-st

• Download MDK-ARM tool chain.

• Activate the free license using this Product Serial Number

(PSN) :
4PPFW-QBEHZ-M0D5M
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Inside Keil uVision (ARM-MDK) 58

Files Window

Project Window

Build Button

Debug Button



The MDK-ARM IDE Debugger 59

Files Window

Disassembly Window

Memory Windows

Register 
Window

Command Window

Program counter  position

Run Button



Step 4: Toggle The LED

In the Keil uVision5 IDE:

• Expand the file tree and open the main.c file

• Add the following code inside the while(1) loop (~Line 118(*) in 
“main.c”)

HAL_GPIO_TogglePin(GPIOA, GPIO_PIN_5);

HAL_Delay(100);

Note: Code within the “USER CODE BEGIN WHILE” / “USER CODE END WHILE” section will be preserved 
after regeneration by STM32CubeMX.

TIP: The code to be added for the labs are located in a text called “code_to_add_vx.x.txt”
(*) Line numbers throughout the presentation are given for STM32CubeMX v5.0.1 and 
STM32CubeG0 Library v1.0.0 and may vary with other versions.
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Step 5: Build the Project and Debug
• Click the “Build” button (F7)

• Click the “Start/Stop Debug Session” button 
(Ctrl + F5)
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Step 5: Build the Project

• Click the “Run” button (F5)

• Enjoy the flashing Green LED (LD4)!

• If you see this warning message due to a minor Syntax error in the startup file, just press OK to 
continue. 

Note: To correct the Syntax error in the 

startup_stm32g071x.s:
- Remove “<h2><center>&copy;” from line 17.
- Remove “</center></h2>” from line 18.
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Lab: PWM (Pulse Width Modulation) Timer



Lab: PWM Timer 64

Objective:

• Now let’s use a more advanced peripheral like the Timer.

• In this lab we are going to configure a Timer in a  PWM mode to blink the 
LED that we previously controlled with a GPIO.

• PA5 has an alternate Timer channel alternate function which is Timer 2 
Channel 1: TIM2_CH1 that we will be using.



Timer - Overview 65

• Multiple timer units providing timing resources

• Internally (triggers and time-bases)

• Externally, for outputs or inputs:

• For waveform generation (PWM)

• For signal monitoring or measurement (frequency or timing)

• Versatile operating modes reducing CPU burden 
and minimizing interfacing circuitry needs

• A single architecture for all timer instances offers 
scalability and ease-of-use

• Also fully featured for motor control and digital 
power conversion applications

Application benefits

Auto-reload

16-bit prescaler

ITR 1 Trigger / clock
controller

Trigger 
output

CK_INT

ITR 2

ITR 3

ITR 4

Capture compare

ETRETR

CH1CH1

CH2CH2

… … 

CHnCHn

Inputs Outputs

CH1CH1

CH2CH2

……

CHnCHn

+/- 16/32-bit counter



STM32G0 timer instance features 66

Feature TIM1
(Advanced Control)

TIM2 TIM3 TIM6 TIM7 TIM14 TIM15 TIM16 TIM17

(General-Purpose) (Basic) (General-Purpose)

Clock source CK_INT
External input pin

External trigger input ETR 

CK_INT
External input pin

External trigger input ETR 
Internal trigger inputs

CK_INT CK_INT CK_INT
External input pin

Internal trigger inputs

CK_INT
External input pin

Resolution 16-bit 32-bit 16-bit 16-bit 16-bit 16-bit

Prescaler 16-bit

Counter direction Up, Down, Up&Down Up, Down, Up&Down Up Up Up

Repetition counter  - - - 

Synchronization Master    - 

Slave   - -  -

Number of channels 6:
 CH1/CH1N
 CH2/CH2N
 CH3/CH3N
 CH4
 CH5 and CH6 output only, not

available externally

4:
 CH1
 CH2
 CH3
 CH4

0 1:
 CH1

2:
 CH1/CH1N
 CH2

1:
 CH1/CH1N

Trigger input  



STM32G0 timer instance features 67

Feature TIM1
(Advanced 

Control)

TIM2 TIM3 TIM6 TIM7 TIM14 TIM15 TIM16 TIM17

Input capture mode   -  

PWM input mode   -  -

Forced output mode   -  

Output compare mode   -  

PWM Standard
Asymmetric
Combined

Combined 3-phase
6-step PWM

Standard
Asymmetric
Combined

- Standard Standard
Asymmetric
Combined

Standard

Programmable dead-time  (CH1-3) - - -  (CH1) -

Break inputs 2 bidirectional 0 0 0 1 bidirectional

One-Pulse Mode   -  

Retriggerable one pulse mode   - -  -

Encoder interface mode   - - -

Timer input XOR function  - - -  -

DMA    - 



Lab: Rename the project 68

• Close Keil uVision5 IDE if it is open

• Open the last STM32CubeMX project (“blinky”) (using File->Recent Projects) and save it as a 
new project name “pwm” (using File -> Save Project As)



Lab: Timer 2 CH1 Configuration 69

• In this STM32CubeMX project we are going to add Timer 2 Channel 1 to blink LD4 (PA5) on the 
Nucleo board.

• In the Pinout & Configuration tab, Expand Timers Categories, then click on TIM2 peripheral and 
set Channel1 to “PWM Generation CH1”.

1

2

3



Remapping Timer 2 CH1 output to PA5 70

• By default the tool will configure Timer 2 CH1 to 
PA0

• We want to remap it to PA5

• NOTE: PA5 is connected to LD4

• Hold “Ctrl” button and left mouse click on PA0

• Then drag the mouse pointer to PA5 and then 
release



Timer Parameters Calculation

• We want the Timer’s PWM output channel to be:

• T = 1 second period (1 Hz)

• D = 50% duty cycle (0.5)

• Timer input clock frequency (TPCLK) is set to 8 MHz.

• Prescaler for the Timer is set to 128. The resulting timer counter clock is: 

CK_CNT = TPCLK / Prescaler = 8MHz / 128 = 62500 Hz

• To get T=1 Hz (or 1 sec period) the Counter Period needs to be set to: 62500
• Counter Period = CK_CNT /  T = 62500 / 1 = 62500

• To get D=50% duty cycle the Pulse needs to be set to: 31250

• Pulse = Counter Period / 2 = 62500 / 2 = 31250
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Clock Tree Configuration 72

Enter 8 (MHz) and then press“Enter”
for HCLK (system clock)

TPCLK



TIM2 Configuration – 4 steps 73

• Select the Pinout & Configuration

• In Parameters Settings of the TIM2

• Configure 1 Hz timer

• PSC Prescaler -1 = 127

• Counter Period = 62500

• Set CH1 PWM

• Pulse = 31250

1

4

2

4

3

1

2

3

Note about Prescaler:  prescaler = PSC +1



Generate Source Code 

• Open the main.c, Add the following code before the while(1) loop in order to start the PWM Timer: 

Note : within “USER CODE BEGIN 2” / “USER CODE END 2” section (~Line 114)

• Generate Code

• Click Open Project

HAL_TIM_PWM_Start(&htim2, TIM_CHANNEL_1);
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Build the Project
• Click the “Build” button

• Click the “Start/Stop Debug Session” button

• Click “Run” button

• Enjoy the flashing LED (LD4)!

• LD4 is flashing using the PWM Timer
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Lab: NVIC + External Interrupts



Lab: NVIC + External Interrupts 77

Objective:

• In this project we are going to configure the GPIO that is connected to the 
user button as External Interrupt (EXTI) with rising edge trigger.

• We will also configure the Interrupt Controller: the NVIC.



EXTI - Key features

• Configurable events

• Active edge selection

• Dedicated pending flag

• Trigger-able by software

• Linked to:

• GPIO, PVD, and COMPx

78

• Direct events

• Status flag provided by related peripheral

• Linked to:

• RTC, TAMP, I2C1,  USARTx, CEC, 
LPUART1, LPTIMx, LSE_CSS and 
UCPDx

• Wake-up from Stop mode, interrupts and events generation

• Independent interrupt and event masks



EXTI - block diagram 79

EXTI

EXTI
mux

Event 
trigger

AHB Lite Control and status registers

GPIO port A

GPIO port B

GPIO port C

GPIO port D

GPIO port F

16

16

16

16

4

16

Configurable 
events

Peripherals without 
interrupt flags

Configurable events

Peripherals with
interrupt flags

Direct events

Event

Masking

Peripherals
exti[15:0]

PWR

sys_wakeup

c_wakeup

Cortex®-M0+

EVG

NVIC

Event input

EVG: EVent Generator



• The NVIC (Nested vector Interrupt Controller) is integrated in the Cortex®-M0+ 
CPU: 

• 32 maskable interrupt channels 

• 4 programmable priority levels

• Low-latency exception and interrupt handling

• Power management control

NVIC - Overview 80

• Supports prioritization levels with   
dynamic control

• Fast response to interrupt requests

• Relocatable vector table

Application benefits



Lab: Pinout Configuration 81

• Close Keil uVision5 IDE if it is open; Open the “blinky” STM32CubeMX project 
(using File->Recent Projects) and save it as a new project named “exti”.

• Add configuration of the IO that is connected to the User Button (connected to 
PC13) to toggle the LED LD4 (connected to PA5) on the STM32G0 Nucleo board.

• PA5 is already configured as GPIO output push-pull.

• Left-click on PC13 and set it to GPIO_EXTI13 mode.



GPIO Configuration 82

• Select GPIO under System View

• Click on Pin Name PC13

• Make sure GPIO mode is “External 
Interrupt Mode with Rising edge 
trigger detection”

1

3

1

2

3

2



NVIC Configuration 83

• Select NVIC under System View

• Enable “EXTI line 4 to 15 interrupts” (by checking the box) 1

1



Generate Source Code 

• Open main.c, add the following code:

• within “USER CODE BEGIN PV” / “USER CODE END PV” section ( ~Line 67)

• Generate Code

• Click Open Project

uint8_t PC13_flag = 0;
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Add EXTI Rising Edge Callback Function
• Also in main.c add the following code,

• within “USER CODE BEGIN 4” / “USER CODE END 4” section

void HAL_GPIO_EXTI_Rising_Callback(uint16_t GPIO_Pin)

{

PC13_flag++;

if ( ( PC13_flag & 0x01 ) == 0x01 )

{

HAL_GPIO_WritePin(GPIOA, GPIO_PIN_5, GPIO_PIN_SET);

}

else

{

HAL_GPIO_WritePin(GPIOA, GPIO_PIN_5, GPIO_PIN_RESET);        

}

}

85



Build the Project
• Click the “Build” button 

• Click the “Start/Stop Debug Session” button

• Click “Run” button

• Push the Blue “USER” button to toggle the LED LD4!
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Lab: Low Power



Lab: Low Power 88

Objective:

• In this lab we are going use the STOP 1 mode and wakeup from RTC which 
is configured to wakeup the STM32 every 5 seconds.

• When the STM32 wakes up it will turn on the LED (LD4) for one second and 
then go back to STOP mode.

• The MCU can also wake-up using the user button which is configured as 
EXTI.



Low Power Modes 89

FlexPowerControl

• Efficient running

• 7 low-power modes, several sub-modes

• High flexibility

• High performance 

 CoreMark score = 142.88

• Outstanding power efficiency

Application benefits

RUN (Range1) at 64 MHz                                                   100 µA / MHz

STANDBY                     130 nA/480 nA* 

VBAT                            340 nA*

SHUTDOWN              40 nA/380 nA

STANDBY + SRAM              320  nA/670 nA*

Wakeup
time

LPSLEEP at 2 MHz                                     32 µA / MHz

RUN (Range2) at 16 MHz                                                 93 µA / MHz

STOP 0 100 µA 

*  : with RTC

Typ @ VDD =3 V @ 25 °C

SLEEP at 16 MHz                                                    42 µA / MHz

LPRUN at 2 MHz                                                90  µA / MHz

STOP 1 4.1 µA*

258 µs

14 µs

14 µs

5 µs

0.7 µs

4 µs

6 cycles



90

Flash memory not powered:
 w/o RTC: 1.3 µA @ 3.0 V

 w/   RTC: 4.1 µA @ 3.0 V
Flash memory powered:

 w/o RTC: 7.0 µA @ 3.0 V

Stop 1 mode
Wakeup time to 16 MHz:
 In SRAM:   5 µs

 In Flash ON:  5 µs
 In Flash OFF: 9 µs

I/Os kept, and configurable

PVD
USART

LP UART
I2C 1
I2C 2
SPI
ADC
DAC

COMP
Temp Sensor

Timers
LPTIM 1
LPTIM 2

UCPD
RNG
AES
CRC

IWDG
WWDG

Systick Timer

GPIO
DMA
BOR

CEC

Available peripherals

HSE
LSI
LSE

HSI16

Available
clocks

Active cell
Clocked-off

cell
Available

Periph and clock
Cell in power-

down

Low Power regulator (LPR) up to 2 MHz

SRAM  
(36 Kbytes)

Cortex M0+

Flash 
memory

Main regulator (MR)

Backup domain

RTC & TAMPER

Backup Register (5x32 bits)

Zzz

Wake-up event

PVD
RTC + Tamper

USART

BOR

LP UART
I2C 1

IWDG
GPIOs

COMP
LPTIM 1
LPTIM 2

NRST

CEC



STM32G0

RTC - Overview 

• The RTC provides an ultra-low-power hardware calendar with 
alarms, in all low-power modes 

• It belongs to the Battery Backup Domain, so it is kept 
functional when the main supply is off and VBAT is present

• The TAMP peripheral features the backup registers and 
tamper detection

91

• Ultra-low power: 300 nA at 1.8 V

• Hardware BCD calendar to reduce software load

Application benefits

VBAT

VDD

PC14 PC13

32.768 kHz

PC15

Power 
switch

RTC

LSE

TAMP



RTC - Block diagram 92

RTC

LSE (32.768 kHz)

RCC_BDCR [RTCSEL]

LSI

rtc_ker_ck
= 
RTCCLK 

Registers
pclk

A
P

B
 b

u
s

HSE/32 Calibration

7-bit 
Asynchronous 

prescaler

15-bit 
Synchronous 

prescaler

Calendar

Shadow 
register

RTC_SSR

Shadow registers
RTC_TR

RTC_DR

ck_spre (1 Hz))

RTC_OUT1

Alarm A

Alarm B

16-bit wakeup auto-reload timer

Timestamp 
detection

• RTC not affected by system reset when clocked by LSE 

ck_apre

RTC_OUT2

tamp_evt

switch to VBAT

Output 
control

TAMPOE

ALARM

TAMP
TAMPALARM

CALIB

RTC_TS
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• Close Keil uVision5 IDE if it is open; In STM32CubeMX open the 
“exti” STM32CubeMX project save it as a new project like 
“lowpower”.

Lab: Low Power



Enable LSE (Low Speed External) Clock 94

• We are going to use the 32 KHz Crystal that is on the Nucleo board (see schematic below) to 
clock the RTC:

• In the Pinout & Configuration tab, under System Core expand RCC and choose 
Crystal/Ceramic Resonator for Low Speed Clock (LSE) clock:



Enable and Configure the RTC 95

• In the Pinout tab, under Timers, expand RTC

• Check the Activate Clock Source

• Select Internal Wakeup for the Wakeup mode



Choose RTC clock source 96

• In the Clock Configuration tab, select LSE as input clock for RTC

Note: For applications that do not require precise RTC timings the LSI (Low Speed Internal RC) 
can be used to clock the RTC  



RTC configuration

Wakeup Counter Calculation:

• To configure the wake up timer for 5s, the WakeUpCounter should be set to 10246 as calculated 
below:

• With RTC Clock set to RTCCLK /16 

• Wakeup Time Base = RTC_PRESCALER / LSE = 16 /(32.768KHz) = 0.488 ms

• Wakeup Time = Wakeup Time Base  * WakeUpCounter = 0.488ms  * WakeUpCounter

==> WakeUpCounter = 5s /0.488ms = 10246
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RTC configuration

• Based on previous calculation we will configure the RTC

• In the Pinout & Configuration tab, click on RTC (under System Core)

• Enter the following configuration:
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Enable Interrupts 99

• In the Configuration tab, go to NVIC settings and then enable the interrupt 
for RTC:

• In the “System View” in the NVIC, check that both RTC and EXTI[4…15] are 
enabled, if not re-enable them both:



Generate Source Code 

• Generate Code

• Click Open Project
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Add code – to main function 

• Open the main.c, add the following code in the while(1) loop of the main function 
in the USER CODE WHILE section (~ line 121):

/* USER CODE BEGIN WHILE */

while (1)

{

HAL_GPIO_WritePin(GPIOA, GPIO_PIN_5, GPIO_PIN_SET);

HAL_Delay(1000);

HAL_GPIO_WritePin(GPIOA, GPIO_PIN_5, GPIO_PIN_RESET);

// enter STOP mode

HAL_PWR_EnterSTOPMode(PWR_LOWPOWERREGULATOR_ON, PWR_STOPENTRY_WFI);

// reconfigure system clock

SystemClock_Config();

/* USER CODE END WHILE */

/* USER CODE BEGIN 3 */

}

/* USER CODE END 3 */
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Add code – to init function 

• Open the stm32g0xx_hal_msp.c, Add the following line of code (marked in red below) 

to the msp init function HAL_RTC_MspInit():

void HAL_RTC_MspInit(RTC_HandleTypeDef* hrtc)

{

if(hrtc->Instance==RTC)

{

/* USER CODE BEGIN RTC_MspInit 0 */

/* USER CODE END RTC_MspInit 0 */

/* Peripheral clock enable */

__HAL_RCC_RTC_ENABLE();

/* RTC interrupt Init */

HAL_NVIC_SetPriority(RTC_TAMP_IRQn, 0, 0);

HAL_NVIC_EnableIRQ(RTC_TAMP_IRQn);

/* USER CODE BEGIN RTC_MspInit 1 */

__HAL_RCC_RTCAPB_CLK_ENABLE();

/* USER CODE END RTC_MspInit 1 */

}

}
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Build the Project

• Click the “Build” button; or use menu Project > Build target. 

• Click the “Load” button (F8) to flash the code into the STM32 (not using the debug session because 
we are using low power modes)

• Press Reset on your board (black button) once the code is loaded and the application will work as 
follows:

• RUN mode for 1 second (LD4 LED on)

• STOP mode for 5 seconds (LD4 LED off ) with wakeup by RTC

• If during the STOP mode (LD4 LED off) you press the user button: the interrupt (EXTI) will wakeup from STOP mode
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Optional Lab: Estimation of power consumption



Optional Lab: Estimation of power consumption 105

Objective:

• Use the Power tool inside the STM32CubeMX to estimate the average 
power consumption of the low power lab we just finished.



Power Supply and Power Source Selection 

• Using the “lowpower” project in STM32CubeMX

• Click on the Tools tab in STM32CubeMX

106

• Select 3V for VDD

• In the Battery Selection section, select AA Alkaline batteries (2 in series, 1 in parallel) as the power 
source for the application



Adding a RUN mode step
107

• Add a step to our power sequence:  

• Click:  Step.. Add

• Configure a first step: RUN mode

• Mode: Run

• Power Range: Range2 -Medium

• Memory Fetch Type: Flash

• VDD: 3.0

• Voltage Source:  Battery

• CPU Frequency: 16 MHz

• Clock Configuration: HSI

• Enable IPs from Pinout function

• Duration: 1 second

• Click “Add”

Resulting step consumption should be 1.6mA

1

1

2

2

3

3

4

4

5

5



Add a STOP1 mode step
108

• Add a second step: STOP1 mode

• Power Mode: STOP1

• Fetch Type: Flash -PowerDown

• VDD:  3V

• Clocks HSI 16 MHz

• RTC enabled (to wakeup the system)

• Step Duration: 5 seconds

• Click “Add”

• Resulting step consumption should be 3.4 uA

• Add a step to our power sequence:  

• Click:  Step.. Add

1

1

2

2

3

3

4

4

5

5



Add a Wakeup from STOP1 mode step
109

• Add a last step: Wakeup from STOP1 mode

• Power Mode: WU_FROM_STOP1

• VDD = 3V

• Voltage source: Battery

• Click “Add”

• Resulting step consumption should be 1.21 mA

1

1

2

2



Average Current Consumption Result
110

• Note: the Current consumption numbers are for the MCU only.



Optional Lab: printf() debugging using UART



Lab: printf() debugging using UART 112

Objective:

• Redirect Printf output to LPUART1 which is connected to the ST-LINK 
Virtual COM port on the Nucleo board

• Using a Terminal like Teraterm we can view the printf output.
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LPUART1 is routed to the ST-LINK’s 
USART, and brought via the USB 

Virtual-COM port class 
(SB16/18 located on the back on the 

board have been soldered)

printf() debugging settings overview

LPUART1 debug will be used via the ST-LINK Virtual-COM port

Set up additional GPIO / Clocks:
PA2 – LPUART1, “LPUART1-TX” 
PA3 – LPUART1, “LPUART1-RX” 
LPUART1 Clock = PCLK1 (64MHz)

LPUART1 settings:
Asynchronous Mode - 115200 N/8/1, No HW Flow control
Tx/Rx,No advanced features

Teraterm Terminal will be used to display the printf output
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STM32G0 USART/LPUART features 

USART features USART1/2 USART3/4 LPUART1

Hardware flow control for modem x x x

Multiprocessor communication x x x

Synchronous mode (Slave/Master) x x -

Smartcard mode x - -

Single wire half duplex  communication x x x

IrDA SIR ENDEC x - -

LIN mode x - -

Dual clock domain and wakeup from Stop mode x - x

Receiver timeout x - -

Auto baudrate detection x - -

Driver enable x x x

Data length 7, 8 and 9 bits

TX/RX FIFO x - x

TX/RX FIFO size (data word) 8 - 8
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Create New Project 

• In STM32CubeMX, click “Home”

• Click Access To MCU Selector

• Select STM32G071RBTx
• LQFP64, 128KB Flash

• Double Click

1

3

2

1

2

3
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GPIO Configuration additions 116

• Click on LPUART1 dialog (under Connectivity), and select Asynchronous mode:

• Use PA2 & PA3 for Tx / Rx pins:

• These are the alternate mapping pins (PC0/PC1 are default)

• So need to remap



Clock Configuration 117

• Run the STM32G0 at 64 MHz for this lab, the LPUART1 clock also at 64 MHz.



LPUART1 Configuration 118

• Click on the Configuration tab and select LPUART1

• Parameter Settings tab

• 115200 Bits/s

• 8-bit word length

• No parity bit

• 1 Stop bit

• Keep Default settings for the rest



Generate Source Code 

• Open Project Manager

• Set the project name (printf) and the project location 
(C:\STM32G0Workshop\STM32G0\HandsOn)

• Set the IDE Toolchain to MDK-ARM V5

• Generate Code

• Click Open Project

3

1

2
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Adding printf redirecting code in main.c

1- Add the stdio include:

/* USER CODE BEGIN Includes */

#include <stdio.h>

/* USER CODE END Includes */

2- Add following code in the section below:

/* USER CODE BEGIN PFP */

/* Private function prototypes -------------------*/

#define PUTCHAR_PROTOTYPE int fputc(int ch, FILE *f)

/* USER CODE END PFP */

3- Add following function in the section below:

/* USER CODE BEGIN 4 */

PUTCHAR_PROTOTYPE

{

HAL_UART_Transmit(&hlpuart1, (uint8_t *)&ch, 1, 0xFFFF);

return ch;

}

/* USER CODE END 4 */
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Adding application code in main.c

Add application code in main loop:

/* USER CODE BEGIN WHILE */

while (1)

{

printf("** Hello World ** \n\r");

HAL_Delay(1000);

/* USER CODE END WHILE */
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Build the Project and run the application
• Click the “Build” button; or use menu Project > Build target. 

• Click the “Start/Stop Debug Session” button

• Click “Run” button

• Open a Terminal emulator like Teraterm, using LPUART1 settings, connect ST-LINK Virtual COM port xx

• You should see the printf message being displayed.
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1 Efficient (Power, Performance and Cost)

Robust (EMS, ECC, Clock Monitoring/Watchdogs, Security) 

Simple (Easy to configure and develop code)

2

3

www.st.com/stm32g0
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We Greatly Value Your Feedback

Use your phone to scan the QR code or type the link into your browser.

https://www.surveymonkey.com/r/8WBPJFF
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Thank you!


